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IMPORTANT SAFETY ADVICE 

 
Warning: Make sure to read the following advice prior to installation or use of the device and the software. If you do not fulfill  
all requirements stated below, this may lead to malfunctions or breakage of connected hardware, or even fatal injuries. 

    

 
Warning: Always obey the rules of local regulations and laws. Only qualified personnel should be allowed to perform laboratory 
work. Work according to good laboratory practice to obtain best results and to minimize risks. 

  
The product has been built to the state of the art and in accordance with recognized safety engineering rules. The device may only 
be used for  
 
• its intended purpose; 
• be used when in a perfect condition. 

 
Improper use could lead to serious, even fatal injuries to the user or third parties and damage to the device itself or other material damage. 
  

 

Warning: The device and the software are not intended for medical uses and must not be used on humans. MCS assumes  
no responsibility in any case of contravention.  
 

 
Malfunctions which could impair safety should be rectified immediately. 
 
 
Grounding  
 
This product is grounded through the grounding conductor on the power cord. To avoid electric shock, the grounding conductor must  
be connected to earth.  
 
 
Orient the Equipment Properly  
 
Do not orient the equipment so that it is difficult to manage the disconnection device. 
 
 
Explanation of the Symbol used  

 Caution / Warning     DC, direct current 
 
 
High Voltage 
 
Electrical cords must be properly laid and installed. The length and quality of the cords must be in accordance with local provisions. Only 
qualified technicians may work on the electrical system. It is essential that the accident prevention regulations and those of the employers' 
liability associations are observed. 
 
Each time before starting up, make sure that the power supply agrees with the specifications of the product. 
 
• Check the power cord for damage each time the site is changed. Damaged power cords should be replaced immediately and may never  

be reused. 
• Check the leads for damage. Damaged leads should be replaced immediately and may never be reused. 
• Do not try to insert anything sharp or metallic into the vents or the case. 
• Liquids may cause short circuits or other damage. Always keep the device and the power cords dry. Do not handle it with wet hands.  
 
 
Requirements for the Installation 
 
Make sure that the device is not exposed to direct sunlight. Do not place anything on top of the device, and do not place it on top of another 
heat producing device, so that the air can circulate freely.  
 
 
  

http://www.multichannelsystem.com/
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Guarantee and Liability 

The general conditions of sale and delivery of Multi Channel Systems MCS GmbH always apply.  

The operator will receive these no later than on conclusion of the contract. Multi Channel Systems MCS GmbH makes no guarantee as to the 
accuracy of any and all tests and data generated by the use of the device or the software. It is up to the user to use good laboratory practice  
to establish the validity of his / her findings. 

Guarantee and liability claims in the event of injury or material damage are excluded when they are the result of one of the following. 

• Improper use of the device. 
• Improper installation, commissioning, operation, or maintenance of the device. 
• Operating the device when the safety and protective devices are defective and / or inoperable. 
• Non-observance of the instructions in the manual with regard to transport, storage, installation, commissioning, operation,

or maintenance of the device. 
• Unauthorized structural alterations to the device.
• Unauthorized modifications to the system settings. 
• Inadequate monitoring of device components subject to wear.
• Improperly executed and unauthorized repairs. 
• Unauthorized opening of the device or its components. 
• Catastrophic events due to the effect of foreign bodies or acts of God. 

http://www.multichannelsystem.com/


ABOUT THIS MANUAL 

MEA Signal Generator • Publication 20221117 • www.multichannelsystem.com 6 

ABOUT THIS MANUAL 

This short manual is an addendum to the elaborate MEA Manual. It is strongly recommended to read the MEA manual first, if you utilize the 
MEA Signal Generator for introducing yourself to the MEA-System. Being already familiar with MEA-System, the MEA-SG will be easy to mount 
and to handle. 

It is assumed that you already have a basic understanding of technical and software terms. 

If you are using the device for the first time, please read the important safety advice before installing the hardware and software, where you will 
find important information about the installation and first steps. 

The device and the software are part of an ongoing developmental process. Please understand that the provided documentation is not always 
up to date. The latest information can be found in the help.  

Check also the MCS web site (www.multichannelsystems.com) for downloading up-to-date manuals and help files. 

http://www.multichannelsystem.com/
http://www.multichannelsystems.com/
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WELCOME TO THE MEA SIGNAL GENEATOR 

The MEA Signal Generator is a convenient tool for MEA users. As a variable substitute for expensive biology you can use the MEA-SG as you 
would set up a research experiment. That means you can test your own products and data acquisition settings without using valuable biological 
samples. It has the advantage that you do not need living material, you reduce the number of animal experiments and save laboratory 
equipment. 

Control button 

Grounding socket 

LED 

DIP switch 

Battery 

Contact pads 

Signal generators are available in four different types: For use with MEA2100-60-Systems and MEA-Systems with 60-electrode MEAs (60MEA-
SG), for use with the USB-MEA256-System with 256-electrode MEAs (256MEA-SG), for use with the MEA2100-120-System with 120-electrode 
MEAs (120MEA-SG), and for use with wireless systems (ME-W-SG). The function of all types is similar. Please read the respective datasheets in 
the Appendix. The picture above shows the 60MEA-SG. 

Important: When using a 60MEA-SG within the MEA2100-HS60 or the MEA2100-HS2x60-System, the contact to the internal reference must be 
disconnected. Otherwise, the delivered signals are not acceptable.  

Please insert the 60MEA-SG in correct orientation as shown on the picture. Your 60MEA-SG is suitable if the contact pad connected to the 
reference electrode is covered with isolation tape or other isolation material. If this is not the case, please cover the designated contact pad 
yourself, for example with isolation tape. 

120MEA-SG, 256-MEA-SG, ME-W-SG 

The produces sine waves or real signals in digitized form. These signals are detected as analog signals with the MEA-System. Because of this data 
source you are able to use and to test the complete MEA-System. 

Each MEA-SG operates in a similar way to the standard MEA probe, but without a biological object. It is possible to simulate 12 different types  
of signals. Furthermore, MCS offers the possibility to program individual signals on special request. Please contact Multi Channel Systems MCS 
GmbH if this is required. 

The base of a MEA-SG is made of printed circuit board. It shows the MEA standard design, the square recording area surrounded by gold contact 
pads. Instead of electrode arrays in the middle, there is a battery for power supply, a blue double DIP switch, a plug socket for grounding cable, 
a control button, and a LED. 

To start a MEA-SG press the control button. To stop it, press the button for longer than two seconds. A flashing LED indicates activity.  
The position of the DIP switch selects different categories of signals (see table below). 

Important: To change DIP switch position, please switch off the device! 

http://www.multichannelsystem.com/
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By pushing the control button, it is possible to select the desired waveform of that category.  
 
For example: Set the DIP switch to switch 1 ON and switch 2 OFF and activate the MEA-SG by pressing the control button. The generator  
now produces EPSPs. Press the button again, and the generator switches to pop spikes, to spikes and back to EPSP and so on. 
 
To save battery power, the MEA-SG will run a desired signal for the duration of one hour and then switch off automatically. 
 

Switch 1 Switch 2 Press button n times Signal Source  
 
OFF OFF 1 

(The MEA-SG is ON) 
Artificial Sine Wave 0.005 Hz 
Note: Sine waves < 1 Hz might not be visible 
because of the hardware filter bandwidth. 

 
  2 Sine Wave             0.01 Hz  
  3 Sine Wave             0.03 Hz  
  4 Sine Wave             1.25 Hz  
  5 Sine Wave             12.5 Hz  
 
OFF ON 1 

(The MEA-SG is ON) 
Hippocampal Slice EPSP 

 
  2 Hippocampal Slice Population Spike 

 

 
  3 Hippocampal Neurons Spikes 

 
 
ON OFF 1 

(The MEA-SG is ON) 
Heart ECG Atrium 
 

 
  2 Heart ECG Ventricle 

 

 
  3 Cardiomyocytes Ventricle FP 

 
 
ON ON 1  

(The MEA-SG is ON) 
Retina: ERG with Spike 

 
 
Table: DIP switch position and corresponding signals    
  
Please adjust the scaling of the x- and y- axis according to the expected signals. To change battery, please lift the clamp with a screwdriver and 
take out the battery. The new battery must be fixed with positive pole facing up! 
 

http://www.multichannelsystem.com/
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SETTING UP AND CONNECTING THE MEA SIGNAL GENERATOR 

A MEA-SG is handled in the same manner as a MEA probe for experiments. For detailed information please read the MEA Manual. 

Mounting instructions:  

→ Open the lid of the amplifier.
→ Place the respective MEA-SG inside.
→ Please orientate the chip as shown on the picture. 
→ Replace the lid and close it carefully.
→ Ground the MEA-SG with a CB-GND cable. 

Handling a MEA-SG 

After starting the software, in this case MC_Rack and adding a data display you see your selected signal, in this case 12.5 Hz sinus waves.  
Please adjust the axes via drop down menus or slider in the header of the display: X-axis 1000 ms, y-axis +/- 50 µV.  

MC_Rack data display 

On this MC_Rack data display channel 66 gets saturated. Check whether this channel is grounded. If not, the gold spring contacts in the lid  
of your amplifier may be defective. Please see chapter "Troubleshooting". 

http://www.multichannelsystem.com/
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Short circuit 
 
The amplitude of the sine waves in the MC_Rack data display above alternates in a range of 100 % and 50 %. Please consider the different levels 
of amplitudes in direct vicinity side by side regarding to the contact pads of the 60MEA-SG, but not to the electrode arrangement in the displays.  
If there is a shot circuit between neighbor pads of contact pads, all electrodes will show the same averaged amplitude.  
 

    
 
Contact Pads  
 
 
Application 
 
AMEA-SG is suitable for many purposes concerning MEA- and MEA2100- and Wireless-Systems that is why it is veryhelpful for new users.  
It is possible to learn about the MEA amplifier and the specific software Multi Channel Suite or  MC_Rack and MC_DataTool as well as other 
software programs. Furthermore, you are able to control the operating mode of the amplifier and you have a tool for troubleshooting. 
  
 
Training 
 
A MEA-SG is optimized for training users, because you are able to use the software and work with the complete MEA-System. AMEA-SG is also  
a good basis for demonstration. 
 
To learn about the software please read the detailed software manuals. You can try out different features of the software and their influences 
on the signal. You can change signal types to make yourself familiar with specifications and parameter values of the offered sinus waves and 
spikes. It is the best practice in software employment, you gain experience and avoid mistakes, which is beneficial for upcoming biological 
experiments.  
  
 
Demonstration 
 
A MEA-SG is a great tool for demonstrating how MEA-Systems work. In contrast to biological experiments, you can be sure that the Signal 
Generator will produce what you want to show, there is no risk of failure, which is always a problem with living objects. 
 

http://www.multichannelsystem.com/
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SOFTWARE 

Multi Channel Suite Software 

With a MEA-SG it is easy to train users on the software Multi Channel Experimenter or MC_Rack, which are specially made for MEA2100-,  
MEA- and Wireless-Systems. 

Together with the MEA2100-System or an USB based data acquisition device and the software package you have a complete setup for data 
acquisition, and MEA-SG generates the data for training instead of an animal experiment. This possibility increases the flexibility of the 
unpracticed user. Please read the software manuals for detailed information. The reasonable "Step by Step" Tutorial gives you an impression 
how the software is generally working, and you can deal with prepared racks.  

If you do not wish to read the complex manuals, MEA-SG gives you the chance of "Learning by Doing". Because of your "mechanical animal",  
you can learn the software features until you feel comfortable.  

The Multi Channel Suite software package is flexible and intuitive to use and supports all MEA2100-Systems, the USB-ME data acquisitions,  
and Wireless-Systems.  

It consists of three tools:  

Multi Channel Experimenter for data acquisition and online analysis  
Multi Channel Analyzer for offline analysis  
Multi Channel DataManager for data export to third party programs 

Multi Channel Experimenter Software 

Use the Multi Channel Experimenter for data acquisition. Insert a MEA Signal Generator to get familiar with the system and the software. 
Please read the manual "Multi Channel Experimenter" for detailed information! 

Building a Rack 

It is very easy to build a rack: Please click onto the button of the desired instrument and move it via drag and drop from the left to the right side 
of the main window! 

It is also easy to connect the instruments: Please click onto one of the symbols on the lower part of an instrument button to connect this output 
port via drag and drop with the input port (symbol on the upper side) of the target instrument. 

Please consider the rules for connecting the instruments. The Multi Channel Experimenter program allows only connections between output 
ports at the lower side of the device to the input port on the upper side of the target device. The input and output ports of the devices are color 
coded for a better assignment of the instruments. 

http://www.multichannelsystem.com/
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Example: Click on the blue symbol output port of the data source and connect it by drag and drop with the blue symbol input port of the filter. 
The electrode raw data stream will flow from the data source to the filter. Connect the blue symbol output port from the filter with the grey 
symbol input port of the recorder. The electrode raw data stream will flow from the filter to the recorder. The grey input port of the recorder 
accepts all types of input data streams and you can connect more than one data stream. 
 
Clicking the button of any instrument with the right mouse provides three options: "Delete Instrument" for deleting the tool, "Edit Instrument 
Name" for changing the name and "Show Info" for information about the instrument. It is not possible to loop instruments. 
  

 
  
Delete a connection between instruments by clicking with the right mouse on the connection path. The command "Delete Connection" appears.  
Please read the Multi Channel Experimenter manual about detailed information about general functions of the different instruments. 
  
Data Display 
  

 
  
Data display of ECG signals of the atrium, delivered from the 60MEA-SG. You see the overview of all electrode channels above and the single 
view of channel 55 below. 
 
 

MC_Rack 

In MC_Rack (the rack you use to record and analyze data online and offline) the data files are independent from each other. You can save and 
reuse a rack for several experiments and generate separate data files. You can then load the generated data file with another rack for further 
offline analysis later. 
 
The main power of MC_Rack is its great flexibility. You can combine various virtual instruments according to your experimental setup. You can 
decide about the fate of each single data stream separately. It is up to you, which data streams are displayed on the screen, which are saved, 
which are analyzed, and so on. This concept saves disk space and computer performance and makes handling of up to 256 channels with up to 
50 kHz sampling rate easy. A status bar informs you of the actual performance of your computer when you record or replay data. Please note 
that the high flexibility of MC_Rack can make a complex configuration of the software necessary please do not be concerned by this. It is easy 
when you know how. 
 
It is very important to note, that all virtual instruments in your rack work independently from each other. As a consequence, they have to be 
configured separately. For example, you have to select the input streams for each instrument separately. 
 
  

http://www.multichannelsystem.com/
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Generally, you will arrange the virtual instruments in your rack in a hierarchical order. The selected data streams flow from your MC_Card or 
from the Replayer (recorded data) into the virtual instrument highest in the hierarchy. Similar to a production line in a plant, this instrument 
picks up only those channels from the data streams that you have assigned to it. It processes this data and produces an output stream, that is 
lead to the virtual instrument(s) next in the hierarchy, and so on. When you build a rack, make yourself clear, which data streams flow to which 
instrument and what output you should expect. If you change the selection of channels for a virtual instrument, you may have to adjust the 
selection for instruments that depend on its output as well. If you have not specified an input for a tool, an error message will inform you. 
  
Getting Started 
 
Here you will find a short description of basic tasks and tools that are needed. Go through this chapter before you start building a rack. 
  
Starting MC_Rack 
 
Double-click the "MC_Rack" icon or select MC_Rack from the "Start" menu. 
  

 
  
The program starts. One dialog box opens automatically. This is your rack. You will now configure your rack and implement the features you 
need to accomplish the task. Your rack is almost empty, it holds only a "Recorder". In the "Recorder" dialog box, you define the path and the  
file in which the acquired data is going to be saved. 
  
Adding a Data Source 
 
1. Click "Data Source Setup" in the MC_Rack main menu "Edit". 
2. The "Channel Layout" dialog opens. 
3. Select your data acquisition from the left "Data Source" drop down menu. 
4. Add the data source "Add Data Source" from "Edit" menu or via icon  
  
Insert a Data Display 
 
1. Click "Add Data Display" from the "Edit" menu. 
2. Adjust the axes according to the expected signals. 
  
Creating a Data File 
 
1. Click the "Recorder" tab. 
2. Browse your folders and select a path. 
3. Type a file name into the text box. 
4. Confirm by clicking "Save". 
 
The file extension for the data files is ".mcd". 
 
The generated files can have a maximum size of 2047 MB. This is a limit of Microsoft Windows.  When this size has been reached, a new  
file is generated automatically. The file name is extended by four digits, counting up, for example Cardio2D-Parameters0001.mcd, Cardio2D-
Parameters0002.mcd, and so on. This allows you to create very large data files. You can also choose that the recording is stopped automatically 
when a file has reached the maximum size (option Auto Stop). 
 
As has been said before, the fate of each single channel is independent from other channels. You can pick specific channels you wish to save 
from all generated data streams. For example, you can decide to save only one channel of raw data, but the peak-to-peak amplitude results  
of all, or of a specific selection of channels. 
  
  

http://www.multichannelsystem.com/
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Replaying Data 

In MC_Rack you can then load the generated data file with another rack later for further offline analysis. The general design of a rack is basically 
the same for online or for offline analysis. The only difference is that you use the "Replayer" instead of the data acquisition device to generate 
data streams, which can be processed by other virtual instruments in the rack. 

First, you define the input data. Because you are going to perform an offline analysis with previously saved data, you need the "Replayer".  
The replayer works like a tape deck; you load a file and you can then start and stop replaying the data streams by mouse-click. 

You can select an instrument in your rack to open the corresponding property sheet. A selected instrument is highlighted in blue. 

1. On the toolbar, click on the "Tape" icon to add a "Replayer" to your rack. The "Replayer" property sheet is opened. 

2. Click the "Replay File" tab. Here, you load the file you like to review or to analyze offline.
3. Click "Browse" and browse your folders. choose the desired file and click "Open". 

Later on, you can choose recently used files from the "Recent Files" drop-down list. Load a file by clicking "Open". 

File Information 

Click the "File Info" tab.  

You see the date and time when the file has been recorded and all important information about the conditions which were used. Click the 
"Buffer Info" tab. On the left pane you see the single data stream or several streams which were recorded, the number of channels, the 
sampling frequency, the gain factor, and the data format. 

Saving a Rack 

Save the rack if you would like to keep it for future use. 

1. On the File menu, click "Save As". 
2. The "Save As" dialog box opens. 
3. Browse your folders and select a path. 
4. Enter a file name and confirm by clicking "Save".

http://www.multichannelsystem.com/
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TROUBLESHOOTING THE MEA AMPLIFIER 

It is possible to control some functions of a MEA amplifier with a MEA-SG. Please read also chapter "Troubleshooting" in MEA Manual.  
Most of the problems with MEA-Systems are rare, and most are minor problems which can be easily avoided and solved. If a problem  
persists, please contact your retailer. With a MEA-SG you are able to check the electrode pins of your amplifier and the general behavior  
due to grounding and shielding the system. 
  
Grounding and Shielding 

Noise level 
 
After mounting a MEA-SG, connecting it to ground, but before switching it on, you first see the noise level 50 Hz hum. The level should  
be comparable on each channel, not too big and without additional interference. If the overall noise is too strong, shielding and grounding  
of the set up is not sufficient. Check the grounding cable and improve the  shielding. The easiest way is to cover the MEA amplifier with  
aluminum foil and connect the foil to any metal part of the amplifier. Another possibility is shielding with a Faraday cage. 
  

 
  
  

 
 
This is how an ideal noise level looks like. 
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Checking the Electrode Pins of the Amplifier 

Noise in single Electrodes 

Starting 60MEA-SG with 12.5 Hz sinus waves you may see the following display: 

Channel 66, 67, 68  show a significant higher level of noise, channel 78 is completely in saturation. That means, there is a problem with  
the contact pad of the 60MEA-SG and / or the electrode pins of the amplifier. To test this, turn 60MEA-SGG by 90 degrees (be careful with 
MEA2100-Systems, because of the contact pad which is connected to the reference electrode). If the same electrodes in the MEA layout are 
affected, the contact of the amplifiers electrode pins are bad, may be the gold contacts of 60MEA-SG too. In most cases this is a problem of 
contamination.  

To repair, clean the contact pads of 60MEA-SG and electrode pins of the amplifier with a soft tissue or a cotton swab and 100% pure alcohol. The 
channels should now display flawless signals (see data display below).  If contamination was not the cause, it may be that the electrode pins are 
defective. Ground the channels if you do not need them, or change electrode pins in amplifier. Please read MEA manual for detailed instructions. 

MC_Rack data display with flawless signals. 

http://www.multichannelsystem.com/
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Scope of Delivery 

1 MEA Signal Generator: 60MEA-SG or 256MEA-SG or 120MEA-SG or ME-W-SG 
1 Lithium Battery CR 1620 (durability maximal 2 years) 
1 With MEA-SG only: Grounding Cable CB-GND 
1  MEA Signal Generator Manual 

Batteries do not belong in normal household waste and, thus, must always disposed of within the framework of existing legislation.  
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CONTACT INFORMATION 

Local retailer 

Please see the list of official MCS distributors on the MCS web site. 

Mailing list 

If you have subscribed to the Newsletter, you will be automatically informed about new software releases, upcoming events, and other news  
on the product line. You can subscribe to the list on the MCS web site. 

www.multichannelsystems.com 

http://www.mul/
http://www.multichannelsystems.com/sales
http://www.multichannelsystems.com/content/contact-form
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